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1.3 AMSNINAAAUN UALIG
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alnsallivuazdidansatindidauan-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives
and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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LLE\’IGIO‘].IuMu']Qa‘VIT,‘H\‘ntI LLaﬂGaﬂﬁjua’]\j — MHL-HDMI (available for selective models)

— Picture — Picture Format — Wide Screen, 4:3
247E6QSD/247E6QSW/247E6QDSD/247E6Q |— Brightness — 0-100
DSW: — Contrast — 0~100
— SmartResponse — Off, Fast, Faster, Fastest
+— SmartContrast — On, Off
— Gamma — 18,20,22,24,26
{— Pixel Orbiting — On, Off
(available for selective models)
f— Over Scan — On, Off
L (available for selective models)
— Volume — 0~100
(available for selective models)
— Audio [— Stand-Alone — On, Off
[ Mue — On,Off
— Audio Source — On, Off
(available for selective models)
— Color Temperature ~— 500K, 9300K
— Color L— sRGB
S L— User Define Red: 0-100
VGA .
Green: 0~100
DVI .
MHL-HDMI . Blue: 0~100
— Language — English, Deutsch, Espaiol, ENMnvik?, Francais,

Italiano, Maryar, Nederlands, Portugués,
Portugués do Brazil, Polski, Pycckuii Svenska,
Suomi, Tiirkge, Cestina, Ykpaincoka, EIEAL,

gy, BAG, Bl

— Horizontal — 0~100

| OSD Settings | Verdal — 0100

— Transparency — Off,1,2,3,4

— OSD Time Out — 5s, 10s, 20s, 30s, 60s
. - , — Auto
wu§1uua~mumau\nuq um.lumuqu | hiposition 00
1u OSD mLammuuu ﬂmmmsnnﬂﬂu I— VPosition — 0-100
VA mmamuuuwaoqamw LwaLaau L Setup — Phase — 0-100
\Aasleas uaznally OK (anav) WRafiudu | ok o100
fILRanuIavin mnﬂauuuﬂ v | Resolution Notifcation — on, ot

— Reset — Yes, No

L Information
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maanasnsidaldsunsuluaangs
AMEINIAARATIIVRALULARA AL
wiauaumaviia'le

PHILIPS

v phillps.comiwelcome

Monitor driver and software installation

usnge e -Wizard (é227a8519)

Tuafousnudsannnisineo
SmartControl Lite tp3avaziila Wizard
(fznaasy) duiniaada TuliGa iy
Msiatdsunsuasousn
fmeaTvazuusinnauAmAunslsy
ANALANRNTTOULUDIADATWLDIAMUT
azdunau

Aarsnsa 'ty Plug-in (windu)
Lﬁmflmﬁamuasw‘lumwa"avmL‘Jjuﬁu
ﬂmmmsaﬂsummanmaﬂ LG
Taelunaslafmaasrolaalanuing
Standard (u165571)



® snarcontl 2%

SmartControl Lite PHILIPS

Wizard

You'l need to calbrate your dsplay to get the most

rocess involve:

B o
Th process mohe =
| tune your dsplay and save the settin
| L. Choose the Start Wizard button
4 2. Follow the steps outlined in this process.
0 3. Save your settings for future use

Adjust Audio
\g Auto prot

-

Cobr o

€

e
2
optons resets
ot Montors

Help

start Waard

H @ususauiuneie Standard
(uassu):

iy Adjust (U3u): 3

iy Adjust (U5u) aygnaluaaliu
Brightness (a31u&319), Contrast (Aa
unsan), Focus (TWAR), Position
(6u1Aug) wag Resolution (Au
avLdam)

. acummsnvhmui”mmau wazvinnslsu
M

« Cancel (anién) azannlanAMAaIN1s

HALANNTHAAYYSA TN
B SmartControl 2.

SmartControl Lite PHILIPS

Brightness
Imoropery acjusted Brightness wil resul n 2 lss of

detai in carker image areas. Adjust the Brightness for
le picture quaity.

he Brightness to the minmum level
2. Raise the Brightness to the desied level
3. Adjust the Brightness as needed to achieve

an equal separation of the strpes.

Brightness

Contrast

Color -
A

g Brightness 100

Options undo Reset

. Resolution

Help

12

W smartcontol

SmartControl Lite

Adjust
Brghtness
Contrast
Color -
A
N Focus
.
\g Postion
Options.

. Resolution

Help

8 smartcontol

SmartControl Lite

Brightness

Contrast

Color an

Focus

AN
\@ Postion
Options

®

4

Help

W8 smartconol

SmartControl Lite

]

Adjust

Brightness

\g Contrast
Color A
AR
Focus

€

Options o

Resolution

4

—

Help

@

PHILIPS

Contrast

e Contrast unti the numbers 1 and 2
er visble.

Contrast to make the
reappear. The number 1

i barely vible

Contrast. 50

Undo Reset

@x
PHILIPS

Focus
Your display’s timing needs to be synchronized with
the vdeo signal

1. Choose Auto Setup.
Tt al bands are stil vble, you'l need

ands disappear.
Phase: Adjust to the brightest settng to minmae
movement on the screen.

e %
ase v
= &
unto At sep
@x

PHILIPS

Position

ter the image on
thi tool, you can posibon the mage
t

Undo Reset




W smartcontol

SmartControl Lite

Adiust

Brightness

\5 Contrast
Color ~a
A
Focus

2

poston
Options ﬁ
Resolton
tiep

wuy Color (&): 3
iy Color (&) auanelnaailsy RGB,
Black Level (s¢6iuds), White Point

(am&w), Color Calibration (n1515u
Wisud) way Smartimage Lite

ﬂmmmsavhmm‘]”umau wagvinnsdsu

A

@

PHILIPS

Resolution

You are currently at a Preferred resolution. For your
disply to show crsp, clear text, Colors, and images,
vour display should be set to s Preferred resolution.
I your dspiay s at 2 Non-Preferred resolution, clck
on the Preferred button to change your resolution to

I™ Enable Resolution Notfier

Picture Format
I™ 43 aspect ratio

QANTIANURN ENFuTIEATIYaE
AU N &)
auFenaadauianly

faenva&mu Color Calibration (A3

Usuiieud)

W SmartControl

SmartControl Lite

Adjust RGB
m:tt';m

Whie Pont

\d "

Deply Garma
-

Options. Calbration

ap

Smartimage

g1

®

Help

@
PHILIPS

Black Level

Impropery adjusted Black Level wil result in 3 loss of
etai n darker image areas. Adjust the Black Level for
the best possble picture quaity.
1. Adjust the black level of the Red, Green, and
Bue usng the sider bars.

Red s0
= &
Green 50
= O <)
Ble 50
= .

undo Reset
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W smartcontol

SmartControl Lite

U "

Adiust RGB.
Black Level
Color Whie Point

Dsoly Gamma
!

Options. Calbration

ap

Smartimage

&%

Help

W smartcontrol

SmartControl Lite

]

n

Adjust RGB
Color White Point.
5
\E Displey Gamma
-l
optons cabratin
ap
smarimage

®

Help

8 smartcontol

SmartControl Lite

1]

"

Adiust RGB.
Black Level
Whke Pont

Display Gamma
optons cabrston
ap

Smartimage

g4

®

Help

@
PHILIPS

White Point

White Point s the pon ich equal combinations

and bive Igh

cobrs clck the Reset button then
e Pon.

1. Please select the White Point value for the best
possble color qualty.

Whte Point 6500K
- lo} +

Undo Reset

PHILIPS

Display Gamma

Gamma is 2 component of the pixel brightness in 3
disply. A lower Gamma vakue produces brighter pixels
and a higher Gamima value produces darker pxek. The
defaut value for Gamm & 2.

To adjust Gamma, Smartimage must be set to Off.
Clck the Smartimage Off button before adjusting
Gamma,

1. Use the sider to select the desred Gamma

Display Gamma 22
= O &
Smartimage Off
Undo Reset

PHILIPS

Calibration

iy calibrated i order
f colors accuratly.

whenever you move your disply to a

1. Make al other necessary adjustments t
qualey fist.

2. Press Show Me to lear how to use the

calibration took.

Frialy, press Start to begn the calibration

¥ Enable color calbration

Color software designed n colaboration with Joseph
Holmes.

Protected by U.S. Patent No. 6,686,953

Show Me start

Quick View



1. "Show Me (u&nal1ig)" Bunssaauien s o

Aunsusuiaud SmartControl Lite PHILIPS
2. Start (3u) - BunszuunsUSuAnud smartimage
6 illu m a u gzni?;:umage provides uﬂevteevg;jv;g vsu \ess ar!:ge o
. . l ' Chanse Nve sem g ﬁa' is wust cm mfortable or
3. Quick View (gaenais?) nanniwnau/ \d o T
&Y b L

Black Level

4. unmsnduladfominaendn Color (&),
adniju Cancel (anian)

5. Enable color calibration (1avinouns
:Js”nmunﬁ) AmBGuaudadda an'lila =,

Whte Pont

Display Gamma

g gﬁ

vinedasniung umuﬂnmﬂuaummw \Q @ —
vinmsdfuiaud du "Eu" uag "gasne e
152" aztduinmiang o &

6. paviizayadniinsluninaanisdiu S
71|

Options>Preferences (étdan>n15
Anuadnaly) — agvitnuniziiialdan
Preferences (nMsiniundnzals) nnLuy
Options (#tdan) vulaugaInanlulasu
AsaduRuunsiauaiunsa DDC/CI, agl
W@wzwin Help (381a1) uaz Options (67
Ll&an) iy

B Smartontrol B

SmartControl Lite PHILIPS

uunaansUsufiaudusn:

Preferences

You can use the following options to configure
rartControl.

P

e!.rems

n right-clicking on desktop

]

Adiust udo

« 1u Previous (naunun) gnflansvineu 7 ey
AaunsTviivnunadnagasy \g

« 1w Next (da'ld) lldouhwnaaa’la (6 i
thnane) s

a

=
Presets

. ﬂunm"lﬂaﬂmua""lﬂﬂwmma
File>Presets (‘lWa>w3idin)

+ Cancel (antdn) fla UI uaznauludy =
w1 Plug-in (wanau)

Multi Monttors

t 1)

SmartImage Lite . uﬂmmss?oﬁhmsrimumﬁnﬂmzﬂaaﬁu
aumm’(uw’tmﬂaﬂuu'ﬂaomsmom Wialu . paaviviesasnang wunisidavineiu
lan1sdemnsudanaiaduaiiam AnLANITH naasnLATagvInetunng
wladean Entertainment (Ayuiiuiia), AusznIIMIRIILUAT LI
SmartContrast uay SmartResponse agiiln + Enable Context Menu (1davinoutuy
¥ingu wlann) uumanmaﬂavanmmsammm

(fla) AuAGuau Enable Context
Menu (tdavinsrutuyiiiam) wagaans

14



t8anuav SmartControl Lite & usu
Select Preset (1@anw3tdia) uay Tune
Display (J5uaausdaina) Tuangiiam
indnauueannail Disabled (la
vineau) au SmartControl Lite anawuy

lannadanann

+ ‘lamau Enable Task Tray (tdavinou
a1091u) gavinesasuang (a) enw
A5uaY Enable context menu (1
vinuylilam) ugasuyanaeu
d& w3y SmartControl Lite Asadnuni
lanauaauu BUIAIAILAANLUYATN
f& sy Help (351%), Technical Support
(Msaduauuaunatia), Check for
Update (asyasaumianian), About
(tAdy) way Exit (aan) ia Enable
task tray menu (tdavinvutuyana
szuu) gnilavinou lanauanaszuuay
wdgagLanig EXIT (aan) winilu

+ Run at Startup (summsumu) gnvin
wdagwing (1la) auaFuay ia
flavinvnu, SmartControl Lite (s
sanautnsa lan) aglndadudasy

ad o

au wiaagluainonu adefiay
SmartControl Lite ﬂﬂatﬂﬂ’»ﬂﬂm‘]ﬁ&tﬂnu
wannal wiannlualdsuasummiy
wiLdalag j?‘n;’folmtfmffu&ﬁal,‘s‘gmu ag'ly
gniviaa Wanaasil'lulaviliedaguning

ag (favinou)

+ Enable transparency mode (1davinenu
Tiualsela) (Windows 8, 7, Vista,
XP) a1i3uauda Opaque (Auuavy) 0%

Options>Input (édan>aunn) - 3y
vinuawziiailian Input (3uwe) ann
tuy Options (¢&an) uulaudasnanlule
Funmsavusuunfiauauisa DDC/CI,
maww"u,mu HeIp (381%) uay Optlons (n
1dan) winifu wiiy SmartControl Lite Auq

Wonumazla'lule

15

W8 smartconrol

X

SmartControl Lite PHILIPS

Adiust

Color

>
Options

=
Help

Input

IMPORTANT! If you s

Analog In Digtal In

. uamwmmwumau Source (uniae
fuana) waznsdemuviaddaana
duneilaaiiu

° UUADUFAINR dll aUNW ALAEN 1/114']61'101431u

uav'luwiu

aa

Options>Audio (Grnaan>18u9) — g
vinulawzilaiian Audio (1&eav) ALy
Options (L8an) winifu
UuRaLEAINAT I laFuNsRTuRYUAfiAL

& usa DDC/CI, mmawuumu HeIp (38
12) wag Options (ft&an) wifu

8 smartcontol

SmartControl Lite PHILIPS

Adjust

Color

>
Options

Help




Help>User Manual (35121>afias1al) -
agviouaniialdan User Manual (mJa
w“lﬂ) iy Help (38120) uulauanonad
"Lu”l,m'sumsaunauumummajmsn DDC/
CI, asfiiawrzuiiu Help (38141) uaz Options
(adan) Nty
B smartControl e

SmartControl Lite PHILIPS

User Manual

Adiust

User Manual

g
{ ®
Color p
\
\[g ’

Options

=

@

Help

X

Verson

User Manual Tech. Support

HeIp>VerS|on (';ﬁ‘tq.l>na's’iiu) - Y
vinnutangiatdan Version (nasﬂ’u) N
iy Help (3ﬁ‘£°u) tuRauEAINAT ATy
msauuauumumwagmsa DDC/CI, azfi
W@wzwin Help (381a1) uaz Options (62
Ll&an) iy

1 smartcontrol @x

SmartControl Lite PHILIPS

Version

Adjust

User Manual

:
7
Color n
. Doy

:
ﬂ
12

Options
XX

a

‘@

Help

Verson
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Context Sensitive menu (rayit
tAtNAAIAULUAKN)

Context Sensitive Menu (Luuw,nmmaa
nmuam) gatdavineu auABuaY

a1 Enable Context Menu (1dlavingu
wyLiian) gavintazavuunalunuinig
Optlons>Preferences (mtaaﬂ>msmvmm
dnmaly) aaasuadiiuluyil

g SmartControl
Select Preset +
Tune Display

wiilanndl 4 shanns:
+  SmartControl Lite — lagan About
Screen (AgAuMINRA) Azuanadiu

» Select Preset (Laanwsvﬁm) My
dluadudusasnwsidariruiinly dwsy
L2f9uui msawmuuammwsvﬁm
danluaqiiu uananil aaanunsa 5
3un Factory Preset (Wiidinls99u) 1a
AALUYIIELANTENAIEL

« Tune Display (U5uraugnina) — tda
wHIAILANUAY SmartControl Lite
+ SmartImage Lite — ATIAFAUMATHIAN

aatiu 1y Standard (unasgu),
Internet (Auwnasiiin), Game (A1)

wyaavutidavineiu

AEINsTaLEAINYAIANUlaTAENSAAN
mmu‘lanauVSmartControl Lite NNaIn
91U Msadnanaazidawadwdiatu

Help

Technical Support
Check for Update
About

Exk




aavudl 5 s1un1s: .

+ Help (381%) — ndvladelna User
Manual (ﬂuaw‘m) ula'lla User
Manual (ﬂuaw‘m) Taalzvinaman
LasiFuau

» Technical Supportv(msaﬁ’uauueim
WAlla) — wEAYRUINTRETUAUUAY
walia

+  Check for Update (a51adaumdwnian)
- uw’tﬂ"lﬂﬂmm PDI wasasiagaw
nasifumaow’lﬂ WnufunasuAusTe
Agaid

« About (\AAL) - udavuayaa19h
apvasane: aYTUNAAAUY, YAy
U uRsiandndun

+ Exit (aan) — @ SmartControl Lite

uns¥u SmartControl Lite 8na¥s 11

tdan SmartControl Lite aanwuy Program

(sunsu) wiaduidandniilanau PC uu
wannal wiaduszuulny

SmartC

PHILIPS

‘SmartControl
‘ersion 3.20
une-standard-R2007-01-04-1151-23
Copyrigft 1993-2007 Pertrat Displays, Inc.
Patents Pending

wiyatavuiaineiu

diaanasugniavinaulutvainas ns
fuaaneay lwizsanTs EXIT (aan)
fAsusaly'le vWwaau SmartControl

Lite aananaiasvuvagvauysal nda
¥i191u Run at Startup (Fuiflazueu) Tu
Options>Preferences (fatdan>n15A1nua
AN UL)
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S uuLILIG
aisznauionualugiud ladniu
AT AU NasTurdanaws
SmartControl a1atldauuaslataely
paad Ny Tusaesragautiulae
waswsaaedun1ens? www. Qortralt

com/dtune/phl/enu/index X [iiaanUTan

aiaWaws SmartControl Lasfuaidataua


www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index

4. ayaINNITAIUNAUA

ANUFLAINFUEUDIN T2

AdUeUaIANTW IPS LCD;

wualan LED

AUANUIAR 23.6W (59.9 aiw.)

AaTFEIUNN 16:9

AUANNLUAR] 0.272 x 0.272 uu.

AU 250cd/m?2

SmartContrast 20,000,000:1

ansnAaunsaEn (1311) 1000:1

nanauauad (1711) 14ms;

SmartResponse 5ms(GtG)

ANURLLALANANFA 1920 x 1080 @ 60Hz

YUNTFUAN 178° (H) / 178° (V) @ C/R > 10

NSLANAATNURINTN SmartImage Lite

gnuanele 16.7 M

2605713 AUUIA 56Hz - 75Hz

ANuUdLUIUAY 30kHz - 83kHz

MHL 1080P @ 30Hz (247E6QDSW/247E6QDSD/247E6QDAW/2
47E6QDAD)

SRGB b1

ANUEINITAAUNSIHaUR:
247E6QSD/247E6QSW: VGA (aundan), DVI
(#3maa,HDCP)

Aunadauano 247E6QDSD/247E6QDSW/247E6QDAD/247E6QDAW:
VGA (aundan), DVI (#3maa,HDCP), MHL-HDMI
(#3maa,HDCP)
247E6QDSD/247E6QDSW: tanawaLdes HDMI

(&aoLan/aan 247E6QDAD/247E6QDAW: 1&a19 PC 121, yWoaan,
la1awaL&ng HDMI

deyanaduna Gvauen, dauudiien

ANUATAINHALNE

247E6QSD/247E6QSW/247E6QDSD/247E6QDSW:

&/« /v /A /0K 0)
247E6QDAD/247E6QDAW:
/< /v (/A /0K 0)

a\mm:r masuu Jly, n3n, WA, aan8, d9n3,
LULEATUAUR, Tisang, Tdsaina usda, Tduaue, Sauds,

Ax OSD

o qau, ﬂuu,auﬂ m‘ﬁ viin, gAsy, ﬁuuwuﬁu‘tum
fulawdy, du, Ln'mﬁ

ANUATAINR LU dam Kensington




ANNFINTAMUNAN & LNAE
21609
GEN

DDC/CI, sRGB, Windows 8/7Vista/XP, Mac OSX, Linux

-5° / +20°

WU

Tuadaia3as

247E6QSD/247E6QSW: 22.26 W(v1'4l), 28.89 W(g9an)
247E6QDSD/247E6QDSW: 22.38 W(vialul), 23.9 W(geqm)
247E6QDAD/247E6QDAW: 23.66 W(vhldl), 27.8 W(geaa)

add (vl

0.5W

o (v'al) 0.3W

Tudaodauy LED tinaas }::%Lf)mﬂiaﬂ: &, ueswauaune/&81: &1
unagne'ln aneauan, 100-240VAC, 50-60Hz

RIS AR A 561 x 429 x 212 .

(nx&xa)

wAnSaunalulgus 561 x 347 X 43 1.

(AXSXA)

HANSUNNIANANGY 3.65 an.

wanAunilalulguee 3.27 an.

waulanisvineu
29NN (UUEVingI)

0°C &g 40°C

aaunnll (varyluvineu)

-20°C &y 60°C

ANUAANAAAILATUINTFIU

nsawihizassufiavua
TIALAN9Y

ANuAdUFUANG 20% &9 80%

MTBF 50,000 21w,

ROHS i

EPEAT sEau (Www.epeat.net)
UFTHUN Flanda'la 100%

FRRBYRE MLA3avnilsndann PVC BFR 100%
Energy Star by

247E6QSD/247E6QSW: ta3avnune CE, FCC aana B, CU-
EAC, SEMKO, tu$usas TCO, ETL, BSMI, 1509241-307,
SASO, KUCAS, EPA, C-TICK aana B
247E6QDSD/247E6QDSW/247E6QDAD/247E6QDAW:
tA3avuune CE, FCC aana B,CU-EAC,SEMKO,1ususas
TCO,ETL,1S09241-307,SASO,KUCAS,EPA, KCC, VCCI aan&
B, C-TICK aa& B

faLA3av
& wudALas/&un
NUR? U



www.epeat.net

S nuLLin

1. EPEAT wisaieynasnsalnsag iy °Z.°1.i"Lm
wnndia Philips aonufiaundndomn
Tulsaudanaui www.epeat.net sy
gauznsadnsidaululssinduavaon

2. rayaiiarauldsunlaslalaglunaduas
Wnu Wi www. philips.com/support
WasmuTuaaunuzayanasfuagn

3. LarauauadAsazdumAffigaann
Asnaday GtG waa GtG (BW)

20

41 anuazidan & TuNANILEn

b anuandaagedn
1920 x 1080 @ 60 Hz (Aunwmaurfan)
1920 x 1080 @ 60Hz (Aunwmaudan)
B aruanbaaiiuusiin
1920 x 1080 @ 60Hz (Aunmauifan)

aNuduu A ANuAuL

uau (kHz) avidun 69 (Hz)
31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
63.89 1280x1024 60.02
79.98 1280x1024 75.03
55.94 1440x900 59.89
70.64 1440x900 74.98
65.29 1680x1050 59.95
67.50 1920x1080 60.00

€ uuuun

TWsansuaaudasnazasnavinuled
naganaNuasdaauasgIu 1920 x 1080
@ 60Hz alwlaaanIWASURAINATIA
nan Tdsavieuduuzinlunisaeaiau
azidaail


www.epeat.net
www.philips.com/support

5. ANTARAITNAIIIU

mﬂmumsmuamwausaqjawmmm
fanAaadiyu VESA DPM mmﬁoau‘l,u PC
UAIAL aamwauammsﬁutﬂaaawaamu
TaudaTwid luaaeiilalalzdou mm‘m
wnmsﬂaumauaa’muﬂuwuw Lma wia
aﬂnimﬂaumamauq aaAnway "dudu”
Taadn Tulid m'swma"l,ﬂul,tamn'ﬁautﬂaaa
WAIIU Ltaunwsaoﬁmm1vmmammauumms
Usendanavouan Tulitil:

247E6QSD/247E6QSW:
ANMNNUNELADINITIANNTWAIIU
dGon | doA
}/222 56872 | ww | ww | wdeowiily & LED
uauy N
2226 W
; ; ()
wanvin fn T o 28.80 W &2
(F980)
sl | au | | W | oswh | nﬁ’_j‘;’u)
dawedag | G - - | 0.3w (vl u

247E6QDSD/247E6QDSW:
ANUNRUNELADIANTAANITNAIIU

Gon | doa
}/222 36Ta | wwd | uw | wdsewiild | &LED
uau o8]
2238 W
i g (i)
uwaniiw fin T o 23.9 W &1
(F980)
sl | e | | B | oswebw | SR
daadas | du - - | 0.3w (vl) &y

247E6QDAD/247E6QDAW:
ANUNRUNELADINATAANITNAIIU

don | 4o
?,Eg: 36Ta | ww | uwd | wdsewiild | &LED
uau o]
23.66 W
: - (il
wanvin 0] Taf af o dam)
(g980)
sl | du | Wi | W | 05w gk (n"i’;‘%)

dowadas | o - - | 03w () i

msevanalilfignluiiaianisdunldas
WRIIULUIAATNIL

«  AuasdaaunasgIu: 1920x1080
«  AAUNTEA: 50%

«  @ANuEN: 250 nits;

+ aaungiid: 6500k wsansluuugun
AUy

S vunein
ﬂuauaumaLﬂaﬂuuﬂaa"lmimﬂ”l,umaauao’tu
NIy



6. AdYALALNAUSLILIU
A2LIALU
Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This product is designed for both you and the
planet!

sustainable [T - manufacture,

use and recycling of IT products
reflecting environmental, social and economic
responsibility.

. TCO Development works for
1]

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for ICT products worldwide.

Some of the Usability features of TCO
Certified Displays:

*  Visual Ergonomics for image quality
is tested to ensure top performance
and reduce sight and strain problems.
Important parameters are Resolution,
Luminance, Contrast, Reflection and Colour
characteristics

*  Products are tested according to rigorous
safety standards at impartial laboratories

* Electric and magnetic fields emissions as
low as normal household background levels

*  Workload ergonomics to ensure a good
physical environment

Some of the Environmental features of TCO
Certified Displays:

*  Production facilities have an Environmental
Management System (EMAS or ISO 14001)

* Low energy consumption to minimize
climate impact

* Restrictions on Chlorinated and
Brominated flame retardants, plasticizers,
plastics and heavy metals such as cadmium,
mercury and lead (RoHS compliance)

* Both product and product packaging is
prepared for recycling

* The brand owner offers take-back options

Corporate Social Responsibility

* The brand owner demonstrates the
product is manufactured under working
practices that promote good labour
relations and working conditions.

The Criteria Document can be downloaded
from our web site. The criteria included in

this label have been developed by TCO
Development in co-operation with scientists,
experts, users as well as manufacturers all

over the world. Since the end of the 1980s
TCO has been involved in influencing the
development of [T equipment in a more user
and environmentally friendly direction. Our ICT
product labeling system began in 1992 and is
now requested by users and |CT-manufacturers
all over the world.

For displays with glossy bezels, the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

For more information, please visit:
www.tcodevelopment.com

I[n Technology for you and the planet

CERTIFIED

(Only for selective models)

User mode is used for TCO Certified
compliance.


www.tcodevelopment.com

EPEAT

(www.epeat.net)

(%  The EPEAT (Electronic
QQ Product Environmental
7 Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:2010+A
12:2011+A2:2013 (Safety requirement of
Information Technology Equipment).

*  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

* EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker).

* EN50581:2012 (Technical documentation
for the assessment of electrical and
electronic products with respect to the
restriction of hazardous substances)

*  EN 50564:2011 (Electrical and electronic
household and office equipment —
Measurement of low power consumption)

following provisions of directives applicable

*  2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

e 2009/125/EC (ErP Energy-related Product
Directive, EC No. 1275/2008 and 642/2009
Implementing)

*  2011/65/EU (RoHS Directive) and is
produced by a manufacturing organization
on 1SO9000 level.

And is produced by a manufacturing

organization on 1SO9000 level.

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.


www.epeat.net

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont congues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences


www.energystar.gov

nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji

Urzdeenic powinne byt zasitane # poiazds 2 preylaczanyem obwodem ochronnye (gniazdo
Kalkiem ). Wapdlgracuface i sohq urzadzenia (kompuser, monitor, druksrkal powinny by sasilane
2 tegn samego drbdla.

Instalacja elekerycena pomiesscrenia powinn mwie
praneel swarciami, w pestaci berpiecanika o warto:
W el catkowitego wybserenia urzadzenia 2 siect zasilania, nalezy wyjné wivczkg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Zaak bezpiecsefstwa "B” potwiendss podnosé uresdseia 2 wynaganiami bezpiecsehstva
whytkowania sawartyini w PN-ULTA2107 § PR-BOE-G

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

warostami lub spad-
X

¢ nie lezalo na kablach systemu kompuieroweo, araz aby kable nic
adzse miodng byboby na i nadeptywad lub porykad sl o nie.

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-

plerwy i

etz wokdl niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

S@RG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILF@RSEL ER LETTE A NA,

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird
empfohlen, die Grundfarben Blau und
Rot nicht auf dunklem Untergrund zu
verwenden (schlechte Lesbarkeit und
erhdhte Augenbelastung bei zu geringem
Zeichenkontrast waéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

(D ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

PEABLROHS

RIEFEAR (RFRETSEREFEENE (EHAFEKRERHS) -
TSI T A ST AR NG BE SNRRTRNE RSB

FREALTR
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BEBTRETE]  x [¢] [¢] [¢] Q [e]
RERAH x [0] [0 o [e] [e]
AEIES | x [¢] [] [¢] [€] [e]
REEAERSE | x [¢] [¢] [o] [¢] [o]
* RIS SE DR RS RUORORE o MR E R  EENS
O RTHABH RN A SRS B
{RFERTRTHEAE FUED 1 T
* ¢ RTIEA A TR B T REN IS E e i
{BTER? ) MERTRRER | BRERT X7 WS
HARARHSHIER (BT HRims)

Q0f smmsmmm

HARRIEIIR (+4), B A EEERTPEE1
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{5 B AN S I 1 3 1l ™ 8 Y5 Je sl H N &
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RIBREAM (SEENFIFAEERNE) FETHRFAUTER
>1.05
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e 140
HERIT &

GB 21520-2008
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EU Energy Label

The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 year

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



o] 7171+ 7F4& Bw)
AR A 772N F
2 el A AgstE 2
N g BHoz su, WE
AolA A 5 o
U
VECI]| vccis

T OB L, 7T A BIGIREMTEEE T,
COEEF, RERETHHATS &R
HNE L TWEITH, TOEENT A
DTV g VEEKIOIELTHET
N3k, ZEEERIIEKECICEND
DEI,
BUREHIAZ IS > TIELWE D A L
T‘Féb\o

_ ik
oM
Pb Hg Cd Cr6+ | PBBs | PBDEs
iYL 0 (0] 0 6] [0] (0]
HIiA 83— (0] [0] (0] 6] 0 (0]
AR R 0 0 [0} 0 0 [0}
| AR
WLED o 0 0 0 0 [0}
LCD /S5 L .
JEAPE | PR
CCFL s oo [0} 0] o} [0}
T
PCBA s [0} [0} (0] [0} (0]
_ SRR
=7V &TAY o 0 [0} 0] 0 [0}
i R
VEIV s 0 [0} 0 0 [0}

* 1 PCBA &7 FIMEIEE AR, CRERE N, WA B LU, o
VTV T—, ART R FuTEE TORMELETL AV THE
MENES,

i1 T0) 3, GRS NAMHEOSERPBREHRZHEZI TEVLT L
RLET,

FE 20 DEMBRL) TEEIE, R OB JIS C 0950 DBIKIC & v
BRI & ENFHEICHIES 5 L RFE®RLE T,

JIS € 0950

28

Information for U.K. only

WARNING - THIS APPLIANCE MUST BE
EARTHED.

Important:

This apparatus is supplied with an approved
moulded 13A plug. To change a fuse in this type
of plug proceed as follows:

1. Remove fuse cover and fuse.

2. Fit new fuse which should be a BS 1362
5AAS.TA. or BSI approved type.

3. Retit the fuse cover
If the fitted plug is not suitable for your socket

outlets, it should be cut off and an appropriate
3-pin plug fitted in its place.

If the mains plug contains a fuse, this should
have a value of 5A.If a plug without a fuse is
used, the fuse at the distribution board should
not be greater than S5A.

NOTE: The severed plug must be destroyed
to avoid a possible shock hazard
should it be inserted into a 13A socket
elsewhere.




How to connect a plug

The wires in the mains lead are coloured in
accordance with the following code:

BLUE -“NEUTRAL'("“N")
BROWN -“LIVE"(“L")
GREEN&YELLOW -“EARTH"("E")

1. The GREEN&YELLOW wire must be
connected to the terminal in the plug
which is marked with the letter "E" or by
the Earth symbol or coloured GREEN or
GREEN&YELLOW.

2. The BLUE wire must be connected to the
terminal which is marked with the letter
"N" or coloured BLACK.

3. The BROWN wire must be connected
to the terminal which is marked with the
letter "L" or coloured RED.

Before replacing the plug cover, make certain

that the cord grip is clamped over the sheath of

the lead - not simply over the three wires.
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7.2 nsauagnal & AnssuilscAu

ahviswauaanm.lmmﬂuﬂsaamuimmssuﬂsvnu uazzamiualumsatusyuRuLGui
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Aayadianadmisuginia glslaziuan:

szind CcSP vunmazdaalay  51a0 nalinnis

Austria RTS +43 0810 000206 €0.07 Mon to Fri: 9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri:9am - 6pm
Cyprus Alman +800 92 256 Free of charge [Mon to Fri:9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri:9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff |Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri: 9am - 6pm
Germany RTS +49 01803 386 853  |€ 0.09 Mon to Fri:9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge |Mon to Fri:9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri:8am - 5pm
[taly Anovo [taly +39 840 320 041 €0.08 Mon to Fri:9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri:9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri:9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri:9am - 6pm
Portugal Mainteq +800 780 902 Free of charge |Mon to Fri:8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri:9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri: 9am - 6pm
Switzerland ANOVO CH [+41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri:8am - 5pm

Aayadanadnisuniinia azduawdai:

szine

maatdulnas

uninaauA LA TNA

Brazil

Argentina

Vermont

0800-7254101

0800 3330 856

Aayadanadnisu fu:

szine

maatduinas

uvunaaanhaquarusinag

China

PCCW Limited

4008 800 008
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www.philips.com/support

Aayadinnadmisugiinia glsidnatvuazariuaan:

Aaa

iHuinas vunaaaniaguaguding
+375 17 217 3386
Belarus N/A IBA +375 17 217 3389
Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A MR Service Ltd +385 (01) 640 1111
Czech Rep. N/A Asupport +420 272 188 300
+372 6519900 (General)
Estonia N/A FUJITSU +372 6519972 (workshop)
Georgia N/A Esabi +995 322 91 34 71
+36 1 814 8080 (General)
Hungary N/A Profi Service +36 1814 8565 (For AOC&Philips only)
Kazakhstan N/A Classic Service Ll.c. | +7 727 3097515
+371 67460399
Latvia N/A ServiceNet LV +371 27260399
+370 37 400160 (general)
Lithuania N/A UAB Servicenet +370 7400088 (for Philips)
Macedonia N/A AMC +389 2 3125097
Moldova N/A Comel +37322224035
Romania N/A Skin +40 21 2101969
Russia N/A CPS +7 (495) 645 6746
Serbia&Montenegro N/A Kim Tec d.o.o. +381 11 20 70 684
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and +386 1 530 08 24
the republic of Belarus | N/A ServiceBy +375 17 284 0203
Turkey N/A Tecpro +90 212 444 4 832
Ukraine N/A Topaz +38044 525 64 95
Ukraine N/A Comel +380 5627444225
Jayadinnad1nisu awdnuila :
szina maatduinas vunaaanhaguarusinag
USA. EPl-e-center (877) 835-1838
Canada EPl-e-center (800) 479-6696
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Aayadinnadisuginia APMEA :

sz ASP  uwunuaadhuguanuding nains
Armenia
AT
Georgia . +97 14 8837911 Sun.~Thu. 09:00 - 18:00
service centre
Kyrgyzstan
Tajikistan
AGOS
Australia NETWORK  [1300 360 386 Mon.~Fri. 9:00am-5:30pm
PTY LTD
Company: Hong Kong:
Hong Kong | Smart Pixels | Tel: +852 2619 9639 Mon.~Fri. 9:00am-6:00pm
Macau Technology Macau: Sat. 9:00am-1:00pm
Ltd. Tel: (853)-0800-987
, REDINGTON | Tel: 1 800 425 6396 ,
India INDIALTD | SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086
Indonesi E—EFR(\:/EI;R\IIVEI;% (Customer Hotline) Mon.~Thu. 08:30-12:00; 13:00-17:30
onesa +62-8888-01-9086 Fri. 08:30-11:30; 13:00-17:30
PERKASA .
(Customer Hotline)
Israel E%m”'cs 1-800-567000 Sun.~Thu. 08:00-18:00
Alphascan Mon.~Fri. 9:00am-5:30pm
Korea Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. R-Logic Sdn Mon.~Fri. 8:15am-5:00pm
Malaysia 1 gng 603 5102 3336 Sat. 8:30am-12:30am
New Zealand \L/t'zua' Group | 5800 657447 Mon.~Fri. 8:30am-5:30pm
Pakistan TV.O’\”CS +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Pakistan
EA Global
Philippines Supply Chain | (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Philips
Singapore Pte .
. o Mon.~Fri. 9:00am-6:00pm
Singapore Ltd (Philips (65) 6882 3966 Sat. 9:00am-1:00pm
Consumer
Care Center)
Computer
South Africa | Repair 011 262 3586 Mon.~ Fri. 08:00am~05:00pm

Technologies
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8. m'sun"lmﬂmw\ &
AauNnLLag

8.1 nsunlaiayun

winfidsenaumadamaneg Aswnsauwnla
"Lm’imuw‘m mﬂmmmmuau Maamnmmm
aadgnmsunlatymumaiiiual dana
funurhauinisgnauas Philips

B ieyvinvinl

Mufinaw (LED l,w-mas“lumm)

- amaguulanaalidauagfu
wndaulvvh wasidauagiaundo
DA

c  WINFA “Lviuu’hnﬂmmnasmmuum

maoaamwam‘lumtmuo OFF (fa) 210
funailulifesirunius ON (1fln)

udinw (LED Lw'ma%l,ﬂuﬁm'n) .
« anglunulanmaniieasiiaag

« anagluuulanaaafadyaadan
ma”l,ﬂmﬂaummasmammamommu
&

. Gmaa'tviuu’(mwmmmnaaamw"l,uum
Avavuauiladusudanea anfi
siauusaldauanaiaida

o paulinslsevdandvoruaraida
vinvuag

UUIDUAAITDAIN

Attention

Check cable connection

. smam*viuu‘lmwmﬂmmaaammﬁau
ma"l,ﬂﬂ\maummasmaonmamomuu
& (‘lvimﬂumsumuanuuaﬂsmanmu)

. rsmaﬂauLwa@nmmmumamwumm
Jauda'lu

« anagluuulaneanfinnasidaas
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1.|a.| AUTO (#aTusif) uvinen
Wondudatuld tu'lawwndaagly
Tuue VGA- aundan mwaqw*;"lmﬂuﬁ
wala aaugusarinnsdiuaianneg wuy
wuuwalanutuy OSD

S uuLLuG

Wondfu Auto (FaTui@) ’Lﬁ”Lu"Lm’tu'ium
DVI-Digital(DVI-A3naa) tilasannlufianu
Fnilu

uavtiiuaiundailsznaln
. ammLuumumaummn"lmﬂmmim

. @dansdiaunalaninainunaIngaeu
uaniud iaanulaaads

+  fanadiunucauiaisgnaiuag Philips
uii

B idauniasdunin

awluagansinane
o dsusunuenwiaalaendu "Auto
(80 Tuaid)" Tudrmuauunanuas OSD

. Wusuwuwenwiaalaiondu Phase/
Clock (1W&/uinn) wav Setup (dvan)
Tudrmuauunan OSD asvintuiilale
winglulvue VGA

Awiuuunuiaa

. msaqaamwmmmnaﬁmmwmtﬁauma"lﬂ
mnﬂ%lﬁnmm wia PC QLI
waTLuunuIEaly

finsnzwdLUUIGY

« dsusuvuennwiaalaWendu "Auto
(80 Tuiid)" Tudrmuauunan OSD

. mdauavlunwiseiaaly Phase/Clock
(1W&/uAn1) wav Setup (mm) Tuia
AMuAunan OSD asvinaudilalawmwiy
Tunue VGA

finsnsnauuuIvUaY

———
= —
——




«  dsusunusnwiaalalondu "Auto
(80 Tui8)" Tudrmiuaunan OSD

. mdauauluuwideiaaly Phase/Clock
(1W&/uAn1) wav Setup (mm) Tuda
MuAunan OSD asvinaudilalawwiy
Tuinue VGA

andsinguaa ludia wdadiaiuly
«  5UAAUNTRAUAZANINEILULNYN
LRAILUNUIRD

21115 "nwAe”, "idsudu” uia "aw

1naa" mmaﬂuaomnmﬂmmmwu,m

. ms“l,ummaomvmmammwuamﬂmma
Luaatﬂus"m Ay anavihluhens
vmsuau usamsannu"tumms AN
A" ia mw'inam ‘uuumaamao
Aol 21015 "udsudu”, "awae” vida
"Mningn" Lﬂuﬂﬂnamsmmsannum
’Lumm'iu‘tawmaa LCD mumnu,m
a1ns "idsudu” wia "awe1e" wia
"wlnga” a”nam wglddianaiu
14 udsanfidatasag

« laviuTdsunsuansuiannasininig
wwdaulmigua Luaﬂm'ﬂaauaamwm
1 laalulaldeu

. L‘ﬂmmmuuaﬂwaLﬂﬁ‘uSLWsﬂumaa
vluseaizg w@ua a1aanw LCD UDIA
azugaafiavndidunwdodelusinng
wasuuiag

- msludevihouanduanas wiawail
waatudmsamnaaciussay anauiu
waluiAnainis "aa”l,m" wia "awAne"
viza "awinan" amasuu,so F9azly
wieldl uarliainsagauuanle ANy
W@emafinandeauuululaiuainu
AuAsavalansiulseiuaasno

awilsagAauiau aaanuululuda

vaaluaa

© emAuasdgansuRaINaay PC
‘l‘vrLﬂu‘IMumLé‘\mﬁuﬁnmmamﬁﬂm
UOTFIULRINTUAAVNATIL UL
VAN

andidien duae #1idu Jaiia uazdan

Usinguununaa

+ enndaagiunaudnmazilnfnas
asadaiaINnlalumatuladdagiiu
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s msunaazdoaiuty Tusaquiaune
A AYRnLAR

N "ilar3as” avaull uarsuniu

AN51119U ' 5

+  aasadiuv "ilawasas” Tl
A369A1 LED wanas‘l,ummuﬂuuan
0SD

fmFuanunamdaiingy gnanis
ﬁuﬂmauawmiﬂﬂ uazdanamunueie
1in1sgnAaas Philips

8.2 ANaUNWULUALY U
SmartControl Lite

107w 1. finsuldaulaninuy

PC 1uluaaniwau war
SmartControl Lite 121lu'la
A51inaa191s?

Bu PC T1d uazgn
SmartControl Lite (811350
AAUINIA "Lam) gusavinenu
"l,mma"Lu ®anaiwiu qeudiu
favaL Lgazmﬁg ‘SmartControl
Lite Tuu tialwiiulaniesnas
Amnzaugninga

Wendfu SmartControl Lite
muwm'm"lmm waamziily
1@1\11uum azmama”}s?
arfimsefiunisealuil aaana
ﬁuﬂumaaﬁmﬁolmma%namw
Tnu
. Lﬂaﬂ‘uauumﬂmasuﬁ'ianswdﬂn"Lﬂmﬂu
Asadu

. Fwealasnasifla

«  fifianssuuu OS wuldlau Service Pack
wsa Patch

*  3u Windows Update uasdwianaanin
way/lasnasifla

« Windows yalunaisfiaanmdanias
visalulatauna

« lumsaum llsaadnani My
Computer (paniILnasuaYIU) LAZARN
1 Properties (nauauii)->Hardware

aau:

A1anu 2.

(912} TH



(8150w35)-> Device Manager (63
z‘z”mmsaﬂnm()

mﬂmmu "Plug and Play Monitor (3a
Mundnuauaiwan)" ugastiuaale
Monitor (aanw), Ao lunasdindo
1vu igvayu SmartControl Lite aan
wazdaag luual

f1aau 3. udvanniitiadge SmartControl

Lite Wiananfiuiiu
SmartControI the “luuau"l‘s
uammumngnuo wiazamIu
aummuammum tinazls
fiu?

deau:  aralflasannazualinasnsniln

aavaaul o unInAululadu
SmartControlLite. anazuadinas
ns1WanaaﬂmLﬂuuuo’Luwam
AN UYL THaaaIUTNAR
1asnasazuatinasnsrWiln vy
mammnnu”tmmmaaummwwa
azualinasnsniln

mmmimnas aU SmartControI
Lite, LLa"mmmmuanﬂsa '
mﬂgm"gumaju sdalan

azusrinunnnuidnasiay
waslulafunsatuauy Tuse
Heanauiutlae Philips uazasa
aamwlnvlmnas SmartControI
Lite Nawiaania’lu

@1a7u 4. Wiamdn? Product

Information (naya
Namnmsm) fizayaudnsuny
Ui ana.,"lsmu'?

aeau:  arauduwanglesn a'sa waiie as

anuAnnsauasaala oy
naiﬂ’umawmmmm ﬁoauuauu
aulnasial DDC/CI amaamnsm
TsaaavanuTuanlasasay
watimasnsrudnnisaidnian
Agaaniulanzasdvasuay
wasnuAnnse fadelasias
au SmartControI Lite uashinda
Wudnuiionss

Attention

Theft Deterrence is Enabled

@1a1u 5. du PIN dwuisuillendiu Theft
Deterrence (iavfunis
2luy) aaviiamels?

deau:  guawinis Philips fidngau
AYRITTUMIAUVAIAMUATATS
ayaIaNIvA AL Wansa
fauanuduianzasuadaanin
TusansrunWendurasfuatus
Anlaviiiamnuszain ns
Fanmsuunaay PIN uaiu
suwm.iauwam‘tmma"ﬂuma
a\mnimmmummamuumwm
widien lunsalidununaan PIN
quﬁn%ms Philips anunsasida
winaaalnduaaiaafiniséa
Alzane ndIANTRTIAFaL
anuiuianzasual Tlsansu
11 Aanssuilalasuanuauasas
mnaladaulunasnissulsyiu
ATFIU

8.3 @raruninwuuang 'l

drnu 1: luansidndeaanin arsiin
au'wvl‘sn'mu'laau.amoman'rm
21 "Cannot display this
video mode Clumm‘smmm
‘inumm'iau"lm)"?
fau: ANuaridaauuging vy
aanwil: 1920 x 1080 @ 60 Hz
- aasddnaaaidaionus annfudan
ma PC zavpaanAuaanniinalinau
wind
« 1u Windows Start Menu (luyB3uuag
Windows), t&an Settings/Control Panel
(n3s&em/umdmruau) u Control Panel
Window (Minagumdmiuau), tian
lamau Display (nsuanina) a1elu
Display Control Panel (twaaiuaunis
LRAIKA), LRanuviu "Settings (A5
Faan)" analauwiiu Setting (nséta
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aau:

aau:

A1), lunaaviifia 'Desktop Area (Wuil
wannay)', Tudaudidauldin 1920 x
1080 wnwafa

vfla "Advanced Properties (AauauiTRidy
§9)" uavdoa1dns 3insalli 60Hz, an
fupén OK (anav)

Burandinasing wagvinddunaud 2
uay 3 WansIadaud PC nasnmugnda
A7 1920 x 1080 @ 60Hz w3a'lu

famauiitnasuatnal DaAADATWLAY
wAavAiaan wavtiauaaaan1w LCD
Philips 2avaaundutanlddnase

aaanwaavaar nntduiila PC uavaal

A0 2: Fas13wmlsaduuzirdusu

[anw LCD famin?
dasausanuuzinlusanin LCD
#fia 60Hz ‘Lunszﬁﬁﬁﬂauiumu
UUNUIAD ﬂmmmsnmmamw
swxlsmwmu"mm 75Hz Ragn

adusunutumiallusa’ly

f1a1u 3: Wa .inf was .icm uu CD-
ROM dAaaz1s? azfhinhvlnstias

1aaen9'ls (Linf uag .icm)?
faalvalasasaviuaanin
wagAm Uftieuduaaulugiia
nlazasnaniafindelasias
Aaufnmasataaudvlasiasuas
aan (WA .inf uay .icm) via
wHulasas Wianaudadeaanw
unafousn ﬂi‘]ﬂﬁmumumamwa
1& (wwu CD-ROM) #iuwsaudu
wandouni lasnasaaniw (lWa
.inf uag .icm) azgndindeing

a6 Tulld

A101u 4: azdluanuanidanlnaae'ls?
fai:

1asnafiflansa/anniln uag
AN ADIAMUALTINAUNIANY

uduaiilyla pasninsaidan
ANuazLdaafinasnsaala
Control Panel (uwvmuau) a9
Windows® Tuifaa "Display
properties (AauaNLTHATURAY
Ha)"

A0 5: azinarlsdiuniaainuduau
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aau.:

aau:

[} 1H

aau:

uaarivinn1sd3ulaniweu
0oSD?

Waenaily OK (anav), nniiu
t8an "Reset (Gudia)" tRaGan
nMsdeadeLinuasTsonunduAu
n

#1074 6: %u13a LCD nunanisiinaiu

w3alu?

Taavil wuginluasiuiu
AvinRadudagnnsnsTunAi
Tuus9 wazlasiululngningd
Au wiaTnalag wuaglufiauAnu
MaaEATaNTAUIaAIN ATIRG
Winulanlufiusodu wiausina
aanumumﬂuuunauamwa
wuuwLY Asvinudianagenan
stnududanlanissudlseduaag
Ao

A0 7: a751inANNAZaIaNURI KN

aa LCD aanv'ls?
dgrusunsvinanuazanalnd
‘lu’hjmuuma“am ams‘umi
vinAuazanafinadnisiiu
vilues Iﬂm‘l?j"laiqﬂwswa
Ltaanaaaa am‘l‘zjmma”mﬂau
121U 1a8a waanaZaa, LEIuaa,
aydilny, LEnL2U, 18

° = & !
A1a1u 8: aunsatldaaunisnvaidaas

[annlaudalu? )
1o aadunsallaauulanisey
AduavRaHIuAIAILAN OSD
Taalznszaunsaaluil

A "OK" (anav) tauaaaluy OSD
(MsuaAINALUKUIIA)

na "Down Arrow" (aﬂﬂim) Wiawdan
sdan "Color" (8) annduna "OK"
(anav) Lwammmsmma finsdean 3
ALNIFIUFAIATURY

1. Color Temperature (aeuuilR): Wia
msmamau‘tuma 6500K U1y
ﬂswnmﬂuimu "au Taafi Tnuduns-
2am", ‘Lu‘um”mamuﬂuﬁm 9300K ag
AT "y TuTnudh-am"



2. sRGB: utﬂumsmmmmsmmwa‘m
uu‘hmmmamﬂauumnmaamaa
ﬁs"mwaﬂnsmmmnmanu (mu
ARBYAARDAR, DN, LATAITUN,
AUAULUDT, “R4)

3. User Define (slzifinuua): wlz
gunsatdananuzaulunisaad
wa9iLay Tnansliuiuay Jiden
uas&uldu

S uwunuua

Asiai ﬁwimpvmiﬁmﬁﬂaoua{amniﬂqﬁuﬁomu
wazngnvinlusaudiu msinilgnudaslugluuy
maammammnannsm (agAAadu) amuﬂﬁﬁﬁ
mmum w2 2004K luiung; amuﬂummﬂmu
aamu wju 9300K tiludiindu AUNANAGITUANE Aa

&2 agil 6504K

A1au 9: mmsmﬂfmumaaan'\w LCD
aléiv PC nsnamﬁu “3a
Mac msm‘(mﬁ"lm’lﬂusa"lu?

fau: 12 aan1w LCD Philips nata3as
fansavitnunuduladu PC
1105514, Mac wazdTnadua
moaunsm ﬂmmaauﬂumao’tﬁ
azualinasanaiadaiaidanna
[anmwlydoszuy Mac 2avam
Tlsafanadiunuaiuie Philips
ADIAMEINTUUDYALNULEY

énaw 10: 3anw LCD Philips uluszuu
nan- u,aum waauIalu?

fnau: 1o 2WANY 4 uguundn-
waua-twat Alnunufulady
Windows 8/7/Vista/XP/NT, Mac
0SX, Linux

fanu 11: n'\wmmumaa uwsanwis
udu uanIwa1e usanwing
alununaa LCD daav'ls?

fau: s ludiadevznsusaann
foridanafiaoiuszaziian
wu anavinluiAanis "iisudu”
wiafiganduluains "amwag"
iaa "nningn uunuIaUaY
AgL a1As "Lﬁsuau" "nMwang"
kD) "wingn" L‘ﬂuﬂsmamsm
firdnAudiluimaTuladivuiag
LCD sunnaua)l a1nns "uds
udu" via "nawane” vida "aw
Taa" agaas 9 weliddlatian

wuly ndvannfidaesas e
vinutdsunsuaniuiaviasis
mandaulmiaua Wanaulaan
Famuivbhiaglulalsem e
vivuuadwatadusinstnunaa
wluseaeq t@ua a1anw LCD
2DIAMAY sudnotiamAiduaw
flodtelufinsldauuilae

0 ddiau

ains Lﬁ%uﬁu wia "nnAne” via "W
Tnan" Aiguuse aglumely waglusuisa
aiauuanle Anudanafinandsauuuly
1asumnuquAsas alanisiulseiuaasae

Mo 12: vin'lurausdnsnadeluuang
Aamunania waznAnvdd
Snusiifisaundin?

aau: W@|NN LCD maaﬂmmmu"l,m
mammmma Baafiunazsuas
meﬂa 1920 x 1080 @ 60Hz

Lwammamwamwam Tusala
ANuazduail

Mo 13: avilandan/Saadunruaaciiu
aund'ls?

faw: Tdsana E/0K wluian 10
mwu,waﬂamaaﬂ/aaﬂﬂnmu
‘imumsmmu‘uu @NINLAIAM

"LLammamm "lszana” duan
LwaLtamamuwaomsﬂamaaﬂ/
&am doriuamoluniwaiuaie

Attention

Monitor control unlocked

Attention

Monitor control locked




8.4 MHL FAQ

1o 1 Suluuiuawainsaidiada
aIFULUKUIIDAUDIANTN
Amau: ‘ ;
. ’T,:J'mmsuaaamwaﬂnsaiﬁaﬁa‘uamm“l,m
Fun155usay MHL wi3a'ly

« uanand aadedndunasfisnaadad
1asun1s5usas MHL Walttaunaansal
dnene

. amaguuulanaaladausandu
wasa MHL-HDMI uazidandunaign
AAYUUIDNTWAIUILRANEUNA (LHY
A UUUN u3a OSD)

. wAaAuN'la¥un1siusas MHL agailu
NN Luaamnaamwmﬂuaauamwa
(ST R Lij] mﬂmwnﬂmmm"luvlmmm
vimuim ’Lumm”m’lﬂauwm MHL ‘Iﬂm
mﬂuammaoaﬂnsmuana visammmaw
wanailnsalfiada

Attention

No video input(MHL-HDMI)

- amagliuulanalnsaifiadazasnaly
"mea‘muﬂmmuﬂmu (aaﬂ) andu
wiwiu Aouay mumammuaomauuu
ADUTAIHA Mmmnmaﬂnsmuanawao
aafiudiuin winaavasaanwardiudu
WILAZURAINIW ﬂmajLﬂuVmaa@s)a@’m
wulalaldandunangnaay annadl
nslaviaiannagilnsaaug Tusenag
Tu

Aanu 2. ﬁ1“lun1wuu1aﬁ1aammaan1w
Avfiaauninen? alnsaifiada
AAIRURGNIINA

Anau:

* wesgu MHL Lﬂummuum 1080p

@30hz mmz\imsmamwmua aune
aamwuaamaaannmmmuu

. ﬂmmwmaamwmuaﬂnuﬂmmwwao
Luammuanu mmamumma"taum
§9 (fMamgiziu HD w3a 1080p) ilawmn
agdsnglusduuy HD w3a 1080p uu
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aan i anflamauatiufinuandon
6 (mamomu QVGA) mwanagéiuu
aﬂnsmuana Luaomnmmwmaaman
uAazQTAMNIWEAIRILURUNAaUAIAUE
avnauuIa vy

d1aau 3. Suliledudavainuuiaauag

ADNAN

Anau:

asagluuulanaaniwuasnaifianine
Tua uasiiasyauldeashndouas
VAN Ltauﬂomaaaﬂnsmuanamﬂ
uanandl ﬂmuamamaan"nshmﬁomﬂu
alnsallaBuale

anaanmwzadnaludarTneludi Ao
mmmLﬁamauﬁamﬂuaﬂnsmsﬁmwu
Lmnmamwmmaaaamw Tdsasiutan ;
s_a:mmauaqmﬂmawﬂomaoaamw wagn
denavainsaifiada

dusutayaiuédu uia FAQ Tusagil
Hu'laeasneilunienisaas MHL org:

h

www.mhlcon ium.or
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